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1. BILDKALIBRIERUNG MIT CCDSTACK 

1.1. Anforderungen an die Darks 
Der Dunkelstrom der SBIG-Kameras ist keinesfalls zu vernachlässigen. Daher ist ein Darkabzug 
auf jeden Fall zu empfehlen. Da sich der Dunkelstrom meiner ST2000XM jedoch nur sehr 
langsam verändert, ist es durchaus möglich, Darks zu verwenden, die bis zu 2 Monate alt sind. 
Aus diesem Grund erstelle ich Darks ausschließlich in astronomisch unbrauchbaren Nächten. 
Die Beobachtungszeit in klaren Nächten ist viel zu wertvoll! 

Die Darks werden mit exakt denselben Einstellungen erstellt, wie die Objekt-Aufnahmen: 

• Gleiches Binning 

• Gleiche Chip-Temperatur 

• Gleiche Belichtungszeit 

Die Anzahl der Darkaufnahmen sollte mindestens so groß sein wie die Anzahl der 
Objektaufnahmen. 

1.2. Master-Darks 
Der erste Schritt in der Bildkalibrierung ist die Erstellung der Masterdarks. Das mache ich mit 
CCDSTACK: 

• Process -> Calibrate -> Make Master dark. 

o Combine Settings: Clip min/max Mean  

o mit der Einstellung 2/2 

1.3. Anforderungen an die Flats 
Um tiefe Aufnahmen zu gewinnen, ist ein sauber gemachtes Flat unerlässlich. Vorausgesetzt, 
man lässt die Kamera auf der Optik ohne sie zu rotieren oder sonst irgendwie zu bewegen, dann 
ist es auch nicht erforderlich jede Nacht Flats zu erstellen. Ich habe bereits erfolgreich Flats 
eingesetzt, die bis zu einen Monat alt waren. Eine kritische Kontrolle, ob sich die Lage der 
Staubkörner verändert hat, ist jedoch unbedingt erforderlich. 

Grundsätzlich erstelle ich durch jeden Filter ein separates Master-Flat. Dabei werden alle Flats 
im 1x1 Binning gewonnen, selbst wenn die Farbe der Objektaufnahme 2x2 gebinnt wurde. Der 
mittlere ADU-Wert sollte 35 – 50% der Sättigung erreichen. Das bedeutet konkret für die 
ST2000XM: Sättigung = 62.000  ->  average zw. 22.000 und 31.000. 

Die Belichtungszeit sollte nicht zu kurz sein (mögliche Beeinträchtigung durch den Shutter) und 
auch nicht zu lang sein, um eine rasche Erstellung der Flats zu ermöglichen. Belichtungszeiten 
zwischen 0,4s und 5 s haben sich als brauchbar herausgestellt. 

Bei diesen kurzen Belichtungszeiten ist es nicht erforderlich die Flat-Darks exakt mit derselben 
Belichtungszeit wie die Flats zu erstellen, sondern es ist ein Master-Bias-Abzug 
beziehungsweise ein Master-Dark mit einer Standardbelichtungszeit von 2 s ausreichend. 

Für jeden Filter erstelle ich mindestens 20 bis 30 Flat-Aufnahmen. In das Master-Flat-Dark mit 2 
s Belichtungszeit gehen insgesamt 50 Aufnahmen ein. 

Für mich kommen zwei Methoden für die Flaterstellung in Frage, die qualitativ ein 
vergleichbares Ergebnis liefern: 
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• Sky-Flat:  Der Dämmerungshimmel, der der Sonne gegenüberliegt wird in einer Höhe 
von etwa 45° bis 60° aufgenommen. Während der Aufna hme wird das Teleskop mit 6-
facher Nachführgeschwindigkeit bewegt, damit sich Sterne von Aufnahme zu Aufnahme 
unterscheiden. Wichtig ist die richtige Reihenfolge der Filter: Halpha / R / G / B / Clear. 
Die Belichtungszeit wird ständig angepasst, um etwa 50% der Sättigung zu erreichen. 

• Monitor-Flat:  Ein weißes Tuch wird in zwei Lagen über die Taukappe des Refraktors 
gespannt. Das Teleskop wird direkt auf einen Monitor mit einem weißen Bild 
geschwenkt, wobei der Abstand des Monitors zur Frontlinse des Refraktors circa 30cm 
beträgt. Damit können vergleichbare Resultate wie beim Skyflat erreicht werden. 

1.4.    Master-Flats 
Der erste Schritt ist die Erstellung des Master-Flat-Darks. Dies erfolgt so, wie bereits in Kapitel 
1.2 beschrieben. 

Das Master-Flat wird mit CCDSTACK folgendermaßen erstellt: 

• Process->Calibrate->Make Master Flat 

• Die Abfrage „dark/bias subtract each flat frame“ mit Ja beantworten und das zuvor 
erstellte Master-Flat-Dark auswählen 

• Combine Settings: Sigma reject Mean / normalize = auto / sigma multiplier = 2 / iterations 
limit = 1 

1.5. Kalibrierung der Objekt-Aufnahmen 
• File -> Remove All Images 

• File -> Open -> alle Objekt-Aufnahmen eines Filters öffnen 

• Process -> Calibrate -> Calibrate 

• Calibration Settings: 

o Dark subtraction: Master-Dark auswählen  und adaption = none 

o Flat Field: Master Flat auswählen und subtract bias nicht  aktivieren 

o Apply to All 

• Adjust Display: DDP aktivieren / Apply to All aktivieren / Auf Autoscale klicken. 

• File -> Save data -> All 
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2. REGISTRIERUNG MIT CCDSTACK 
Die weitere Vorgangsweise unterscheidet sich, je nach dem ob das fertige Bild in der 
Originalauflösung dargestellt werden soll, oder ob mittels Drizzle das Bild um den Faktor 2 in der 
Größe hochgerechnet werden soll. 

2.1. Registrierung mit Originalauflösung 

2.1.1. Luminanz-Registrierung 
Als erstes werden die Luminanzaufnahmen registriert. Als Referenzaufnahme sollte eine 
Aufnahme gewählt werden, die möglichst scharf ist und sich möglichst in der Mitte der Ditherung 
befindet. Dabei verwende ich beim Luminanz-Dithern meist einen Versatz von 1 Pixel (Quadrat 
mit 5x5 Pixel ergibt 25 Positionen).  

Wenn man sich sicher ist, dass es zu keinerlei Rotation zwischen den Einzelaufnahmen 
gekommen ist (was jedoch nur selten der Fall ist), dann kann man mittels FFT und der Option 
„Shift Only“ am einfachsten eine sehr gute Ausrichtung erreichen. Wenn Rotation erforderlich ist, 
dann ist FFT nur zum Vorausrichten sinnvoll. Die genaue Ausrichtung erfolgt anschließend 
mittels Star Snap. Dabei wähle ich mittels „Select Reference Stars“ jeweils einen Stern in jeder 
der vier Bildecken sowie einen Stern in der Bildmitte aus. Der Stern in Bildmitte wird als Letzter 
ausgewählt (=Rotationszentrum). Die ausgewählten Sterne sollten hell sein, jedoch nicht 
gesättigt sein. Nach Durchführung der Ausrichtung mit „Align All“ ist mittels Blinken eine 
Überprüfung der Ausrichtung durchzuführen. Manchmal führt bei einzelnen Bildern eine 
manuelle Vorausrichtung beziehungsweise eine andere Wahl von Sternen zu einem besseren 
Ergebnis. 

Wenn man mit der Ausrichtung zufrieden ist, erfolgt das Resampling mittels Apply -> Cosine 
(undersamplete Bilder) oder mittels Apply -> Bicubic Bspline (oversamplete Bilder). 

Die ausgerichteten Einzelaufnahmen werden am besten in einem separaten Ordner (z.B 
align_lum) zwischengespeichert. 

2.1.2. RGB-Registrierung 
Die Registrierung der RGB-Aufnahmen erfolgt sehr ähnlich wie die Luminanzregistrierung. 
Zuerst wird das Luminanzbild, das als Referenz für die Luminanz herangezogen wurde, 
geöffnet. Dann werden alle RGB-Bilder auf einmal geöffnet. Damit werden bei 2x2 gebinnten 
Farben die Bilder automatisch auf die richtige Größe hochgerechnet. 

Danach kann genauso vorgegangen werden wie bei der Registrierung der Luminanz. Bei 2x2 
gebinnter Farbe ist es jedoch manchmal hilfreich hellere Referenzsterne zu wählen, die 
durchaus auch ein wenig in die Sättigung laufen können. 

Die ausgerichteten RGB-Einzelaufnahmen werden am besten in einem separaten Ordner (z.B 
align_rgb) zwischengespeichert. 

2.2. Drizzle 
Beim Drizzle-Verfahren erzielt man die besten Ergebnisse, wenn bereits beim Dithern ein nicht 
ganzzahliger Pixel-Versatz gewählt wurde (z.B: 0,5 Pixel) und wenn genügend Einzelaufnahmen 
für bestes S/N-Verhältnis vorliegen. Die Farbe muss auf jeden Fall im 1x1 Binning gewonnen 
werden. 

Zuerst werden alle Luminanz-Aufnahmen um den Faktor 2 hochgerechnet. Das erfolgt am 
Besten mittels  
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• Edit->Transform->Resize->Specify Scale  

• Magnify = 2 

• Interpolation = Nearest Neighbor 

Danach erfolgt das Registrieren der Luminanz und der Farbe genauso wie bei Originalauflösung 
(Kapitel 2.1). Jedoch bei der Interpolationsmethode sollte bei Drizzle „Nearest Neighbor“ 
verwendet werden. 
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3. MITTELUNG MIT CCDSTACK 

3.1. Normalize 
Damit die Data Reject Funktionen optimal funktionieren, ist eine saubere Normalisierung der 
Einzelaufnahmen notwendig. 

Das funktioniert in CCDSTACK normalerweise sehr gut mit folgender Einstellung: 

• Stack -> Normalize -> Auto 

Dabei ist es im Allgemeinen nicht notwendig einen Bereich zu selektieren. Nach der 
Normalisierung erscheint ein Information-Fenster, in dem man sich die Scale-Faktoren der 
einzelnen Bilder genauer anschauen sollte. Alle Faktoren sollten sich im Bereich zwischen 0,7 
und 1,3 bewegen. Ansonsten hat entweder die Normalisierung nicht funktioniert oder es ist ein 
Hinweis, dass die Einzelbilder unter sehr unterschiedlichen Bedingungen gewonnen wurden und 
eventuell noch schlechte Bilder aussortiert werden sollten.  

Wenn man sich sicher ist, dass die Aufnahmen bei sehr guter Transparenz gewonnen wurden 
und nur der Himmelshintergrund variiert (z.B. durch Mondeinfluss), dann besteht auch die 
Möglichkeit alle Bilder gleich zu gewichten und nur einen Offset abzuziehen: 

• Stack->Normalize->Control->Offset 

• Auswahl eines großen Bereichs, der viel Himmelshintergrund enthält. 

Die Auswahl des Referenzbildes ist bei der Luminanz eher unkritisch, bei den RGB-Bildern sollte 
man jedoch in jedem Kanal eine Aufnahme auswählen, die bei besonders transparentem 
Himmel und in möglichst großer Höhe (Einfluss der Extinktion) gewonnen wurde.  

Wenn man ein Filterrad einsetzt, dann ist es hilfreich bei der Gewinnung der Einzelaufnahmen 
ständig zwischen Rot, Grün und Blau zu wechseln. Anschließend wählt man für die 
Normalisierung drei aufeinander folgende R, G und B-Aufnahmen aus, die bei großer Höhe und 
bei sehr transparentem Himmel gewonnen wurden. Dadurch wird die Korrektur der 
Farbgewichtung gegen die Extinktion deutlich erleichtert. 

Zum Abschluss kann die Güte der Normalisierung visuell sehr einfach kontrolliert werden: 

• Adjust display -> apply to all aktivieren 

• Blinken der Einzelbilder -> Alle Bilder sollen gleich hell erscheinen. 

3.2. Data Rejection und Mittelung 
Unter Data Rejection versteht man das Ausschließen von einzelnen Pixel in Einzelbildern aus 
dem Mittelungsprozess. Damit ist es möglich, Satelliten, Flugzeugspuren, Cosmics, Hot/Dark 
Pixel und andere Artefakte, die nur in Einzelbildern auftreten zu eliminieren. Es können sogar 
bestimmte Nachführfehler,  weggerechnet werden (Wenn z.B. die Nachführung während der 
gesamten Belichtung sehr gut funktioniert hat und nur für einen kurzen Moment der Leitstern in 
eine Richtung ausgewandert ist, so dass nur bei helleren Sternen Nachführfehler erkennbar 
sind).  

Vorausgesetzt, die Normalisierung wurde sauber durchgeführt, dann ist die Data Rejection in 
CCDSTACK sehr einfach. CCDSTACK empfiehlt Poisson Sigma Reject, jedoch ich bevorzuge 
STD Sigma Reject, vorausgesetzt es stehen mindestens sechs Einzelaufnahmen (besser 
deutlich mehr) zur Verfügung. Mit folgenden Einstellungen ergeben sich bei meinen Aufnahmen 
fast immer sehr gute Resultate: 

• Stack -> Data Reject -> Procedures 
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o STD Sigma Reject 
� top image % nicht  aktivieren, statt dessen factor direkt eingeben. 

• typischer factor bei 6 Einzelaufnahmen: 1,8 
• typischer factor bei 20 Einzelaufnahmen: 2,2 

� Kein iteration limit 
� Clear before apply aktivieren 
� Apply to all 

Durch die rote Einfärbung aller rejected Pixel kann der Prozess sehr gut kontrolliert werden und 
der factor bei Bedarf angepasst werden.  
Wenn man mit der Auswahl der zurückgewiesenen Pixel zufrieden ist, dann erfolgt die Mittelung 
der Einzelaufnahmen mit dem Befehl:  

• Stack->Combine-> Mean 

3.3. Deconvolution bei Drizzle 
Es ist bei undersampelten Bildern im Normalfall zwecklos eine Deconvolution durchzuführen. Im 
Fall von gedrizzelten Aufnahmen (siehe Kapitel 2.2) kann es jedoch bei der Luminanz durchaus 
Sinn machen, eine leichte Deconvolution zu versuchen. Dabei haben sich folgende 
Einstellungen als brauchbar herausgestellt: 

• Process->Deconvolve 

o Nicht gesättigten Referenzstern auswählen 

o Positive constraint: 30 bis 35 

o Deconvolve Knopf drücken 

Den Positive constraint Wert so wählen, dass keine dunklen Ringe um Sterne entstehen. 
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4. RGB- UND LUMINANZ-EXPORT 

4.1.  Feinausrichtung 
Bevor das RGB-Bild zusammengebaut wird, ist es sinnvoll noch einmal die Ausrichtung der 
gemittelten L, R, G und B Bilder zu überprüfen. Im Normalfall ist keine weitere Feinausrichtung 
erforderlich. Sollte eine Ausrichtung dennoch notwendig sein, dann wird genauso vorgegangen 
wie in Kapitel 2 beschrieben und die gemittelten Farbkanäle werden auf die gemittelte Luminanz 
ausgerichtet. Nur bei der Interpolationsmethode muss Bicubic B-Spline gewählt werden. 

4.2. RGB-Gewichtung 
Für den weiteren Verlauf der Bildbearbeitung ist eine gute Farbgewichtung des RGB-Bildes ein 
sehr wichtiger Faktor. Im pdf-Dokument www.astrophoton.com/tips/Farbbalance.pdf wird die 
Ermittlung von RGB-Gewichtungsfaktoren ausführlich beschrieben. Bei niedriger Objekthöhe ist 
es sehr wichtig, dass die Faktoren gegen die Extinktion korrigiert werden. Bei der Festlegung 
der Objekthöhe wird jene Aufnahme verwendet, auf die normalisiert wurde. Dabei muss 
allerdings beachtet werden, dass die Extinktionskorrektur nur bei sehr guter Transparenz 
verlässliche Resultate liefert. Schlechte Durchsicht bewirkt eine zusätzliche Schwächung des 
Blaukanals gegenüber dem Rotkanal.  

Wenn man die RGB-Gewichtungsfaktoren bestimmt hat, dann werden das gemittelte G-Bild und 
das gemittelte Blau-Bild mit den jeweiligen Faktoren multipliziert:  

• Process->PixelMath->Multiply by 

4.3. RGB-Erstellung 
Die nun richtig gewichteten Farbkanäle werden abgespeichert und die Farbkanäle könnten zum 
Beispiel in Photoshop zusammengebaut werden. 

Es ist jedoch sinnvoll vor dem Photoshop-Import ein DDP durchzuführen. Dazu muss zuerst ein 
RGB-Bild erstellt werden: 

• Color->Create  

o Luminance: None 

o Filter factor: = Einzelbelichtungszeitverhältnisse (bei meinen ST2000-Aufnahmen: 
R=2/G=1/B=1) 

o Set Background: dunklen Hintergrundbereich selektieren 

o Apply 

Die Farbgewichtung wurde bereits manuell im vorigen Abschnitt durchgeführt. Also wäre eine 
Gewichtung bei Color-Create von 1:1:1 zu erwarten. Allerdings berücksichtigt CCDSTACK die 
Belichtungszeit, die im FITS-Header steht. Wenn also unterschiedlich lange 
Einzelbelichtungszeiten gewählt wurden, dann muss bei filter factor das Verhältnis der 
Einzelbelichtungszeiten eingegeben werden. Da ich in Rot doppelt so lange belichte wie in Grün 
bzw. Blau ergibt sich das Verhältnis R=2/G=1/B=1.    

4.4. DDP 
DDP sollte sowohl auf das RGB als auch auf das L-Bild angewendet werden. Wenn man nun im 
Adjust Display Fenster DDP aktiviert und auf Autoscale klickt, dann hat man einen guten 
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Startwert. Der Background sollte auf jeden Fall etwas reduziert werden, damit es auf keinen Fall 
zum Beschneiden des Histogramms bei den tiefen Werten kommt.  

Wenn man mit den Einstellungen zufrieden ist, dann wird das Bild als 16 bit scaled tif 
abgespeichert, das danach in Photoshop importiert werden kann. 

 

 


